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General Data Entry Information

Tables
In the CatBase database there are a number of tables in which you will keep

your data. The two principal tables are Companies and Products; these are the
tables from which you will draw data to produce your publication. (Note: these
tables may have different names in your database if they have been changed by
your Database Administrator. The one that we refer to as Companies contains
information such as name, address, phone numbers, etc., and the table that we
refer to as Products contains more descriptive information.)  If your publication
consists of just your own company’s products, you might not need to use the
Companies table at all. On the other hand, if you are using CatBase to maintain a
membership or personnel directory, you might not use the Products table at all.

Related Tables
Associated with these two tables are Company Contacts, Product Details, and

Category Entries. The Company Contacts table is related (linked) to the
Companies table, and lets you keep information on as many contacts as you
need for each company. The Product Details table is related to the Products
table, and lets you maintain information on as many detail records for each prod-
uct as you need. For example, you might have several sizes available for one
product, and want to produce a listing in your catalogue like this:

Product Name
Product description, which can be of any
length.  This product comes in various
sizes:
Size Price Shipping
14 oz £19.95 £2.50
20 oz £25.95 £3.00
40 oz £39.95 £4.50

In this case, there are three Product Detail records related to one Product
record.

The Category Entries table is related to both the Companies and Products
tables. This table keeps track of which categories each Company or Product
record has been put into. 

The following diagram illustrates how the various tables are related:
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In other words:
• Each Company record can have any number of Product, Contact, and

Category Entry records related to it
• Each Product can be related to ONE Company record, and to any number

of Product Detail and Category Entry records.
• Each Contact can be related to only one Company.
• Each Product Detail record can be related to only one Product.

You may also want to use the Colours and H&J tables to set up the colours,
and Hyphenation and Justification formats you want to use in your Export Style
Sheets (setting these up is described in detail in Chapter Two, Setting Up Your
Database).

You access the data entry screens for each table by making a choice from the
Data menu at the CatBase main screen or by clicking on one of the buttons on
the Options palette. For simplicity, we will refer to the Data menu in these notes.
The Data menu looks like this:
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The use of each table is explained in the following pages. To illustrate, we will
enter data into a new record as we describe the data entry screens. We suggest
that you follow along on your computer to learn how to use the features
described.

Layout Pages
Many tables contain more fields than will fit on one screen. The data entry

screens for these tables consist of two or more layout “pages.” You move among
the layout pages by clicking on the tabs at the top of the screen.

Data Entry Screens
Following is some general information about using the data entry screens.

Choice Lists
Some data entry fields have choice lists attached to them. These fields can be

easily recognised by the small black arrow displayed to the right of the field, like
the Country field on the Address tab of the Company record:

The purpose of Choice Lists is to simplify and standardise data entry. To make
a selection, simply click on the little black arrow. A list of choices pops up, from
which you make a selection. Your choice will be copied into the field for you. You
can also enter data into these fields directly; CatBase will check to see if your
entry is contained in the associated list and if it is not, then you will be given the
option of adding it if you have been given list modification privileges (see Chapter
Two for more details). 

Choice Lists are explained in detail in Chapter Two, Setting up Your Database.

Included Lists
On some data entry screens you will see lists of data that are related to the

record being viewed. These lists are called included lists; they include data from
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another (related) table in the database. For example, on the Contacts/Memos tab
of the Company record there is an included list for Contacts. It looks like this:

Most included lists display summary information from records in the related
table. In the example shown here, the sort order, first name, surname, title, and
Primary flag are displayed for each Contact.

To view the complete record, simply double-click anywhere on the line item
whose information you want to view. 

To create a new line item, click on the Add button which you will find near the
list. 

To delete a line item, first click somewhere within the line item. Near the
included layout you will find a button named “Delete” or “Delete Item” or similar.
Click on this button. 

Sorting Included Lists
You can sort included lists by any column by clicking in the column title. For

example, to sort the Contacts by Title, click in the Title heading. Several things
change:

• The Title heading shows that it is selected.
• The records are sorted by Title
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• A small triangle has appeared in the top right-hand corner of the area: 
. This is the Sort Direction button – click on it to reverse the sort direction.

The Data Entry Button Box

On most data entry screens, you will see a box at the bottom of the screen
which looks like this:

These are buttons you can use to navigate among records in a list, scan some
text into the database (currently, Macintosh only), and save or cancel a record.
Some buttons may be dimmed, depending upon whether their functions are
appropriate for the current situation. For example, if you have come to the record
directly (i.e., not by double-clicking on it from a list), the top row of buttons (the
record navigation buttons) will all be dimmed.

The top row of buttons consists of the four record navigation buttons, avail-
able if you have created a list of records to view and then double-clicked on one
of those records to view it. 

The Current Selection
You should understand the idea of the current selection of records to appreci-

ate how useful these buttons can be. The current selection is the active list of
records. For example, if you choose Companies from the Data menu and then
click on All Records in the Search dialogue, you will see a list of all the Company
records in the database; this is the current selection. If you search for all compa-
nies having names that begin with the letter A, then the current selection consists
of all Companies starting with “A”. If you double-click on any one of the records
in the current selection, the record navigation buttons will be active. You can use
these buttons if you want to browse through the current selection of records; you
do not have to close a record and then double-click on the next one in the list.
You can open the first record in the current selection, make any changes neces-
sary, and then click on the Next Record Button to move on to the next record.
Any changes you have made will be saved automatically. 

Button Action Keyboard (Mac) Keyboard (Win)

First Record Button Command-F Ctrl-F
Moves to the first record in the current selection.
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Previous Record Button Command-E Ctrl-E
Moves to the previous record in the current selection.

Next Record Button Command-N Ctrl-N
Moves to the next record in the current selection.

Last Record Button Command-L Ctrl-L
Moves to the last record in the current selection.

The bottom row of buttons consists of the Scan Text and Save/Cancel but-
tons.

Scan Text Enter key N/A
Scan text directly into the selected field. To use this option you must
have a suitable scanner connected to your computer, and a copy of

TextBridge Pro OCR software (Version 8 or later) installed. 

Save Record Button Enter key Enter key
Saves the current record and closes it. Any changes you have made to the

record are saved.
Note: If you want to save changes to a record without closing it, you can

choose Save (Command-S on Mac or Ctrl-S on Windows) from the File menu.
This will save the changes you have made and leave the record displayed on the
screen.

Cancel Record Button Command-dot Ctrl-dot
Cancels the current record without saving any changes you have made to it. If

you have made changes to the record, CatBase will ask you to confirm that you
want to abandon your changes. Note that if you have used the Save command
(Command-S), cancelling the record will not undo changes that were already
saved.

Categories
You can select one or more categories for each Company and Product record.

Depending upon what selections were made in the Setup screen, you may be
required to select a category for each company or product. This is explained in
Chapter Two, Setting Up Your Database. 

Categories are useful if you want to create a publication sorted by category.
You can select categories either by name or by number; CatBase will look up the
other for you. You can add categories either by clicking on the Add Category but-
ton (which is located below the Categories included list on the data entry screen)
or by making a selection from the Categories floating palette.

Selecting Categories
Click on the Add Category button and you will be asked for the name or num-
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ber of the category you want to add:

✏ Type in the name or the number of the category. Note that if you are typing
the category name, you don’t have to type the whole thing; you can type
just the first part of the name and CatBase will look to see what matches it
can find. If it finds more than one, you will see a list from which you may
make a selection.

✏ Click on OK to add the category.

You can also select categories from the Categories floating palette, which is a
little window that looks like this:

If you can’t see this window on your screen, that is because in your
Preferences you have elected not to display it. To change this preference, click
on the Prefs button in the CatBase Options palette or choose Preferences
from the File menu at the main CatBase menu screen. The Preferences window
will open; click in the Show Category Palette check box to select it. The next
time you open a Company or Product record, the Categories palette will appear
(if you already have a record open, you’ll need to close it  and re-open it).

The Categories palette contains three columns for the three levels of
Categories. Initially, only the Level One categories are displayed. Click on any
Level One category and all of its associated Level Two categories will then
appear in the Level 2 column; click on a Level Two category and its associated
Level Three categories will appear in the Level 3 column. 
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Column Width
You can change the width of the columns. To do this, move the mouse pointer

up to the bar  that separates the column headings – the pointer should change in
appearance so that it has two arrows pointing east and west. Hold down the
mouse button and move it sideways to make the column wider or narrower. 

Re-sizing the window
You can also re-size the entire window by clicking on the bottom right-hand

corner and dragging it to make the window  larger or smaller. 

If you move the Categories palette or re-size it, the new settings will be saved
when you Quit from CatBase so that next time you use the database, the window
will appear in the same place as you left it.

If you do select categories, one category for each company record must be
designated as the Main Category. The first category you select will automatically
become the Main Category. The Categories included list area on this screen
might look like this after you had added one category:

If you select additional categories, you could designate any one of them as
the Main Category by double-clicking on the appropriate line in the list of cate-
gories. The Main attribute can be used when you are exporting records sorted by
Category; see Chapter Seven for a detailed explanation. You might select 3 or 4
categories for each company record, but perhaps the main category is more
important than the additional categories. 

Deleting Categories
To delete a Category from the Categories list, click on it once to select it and

then click on the Delete category(s) button. You can delete more than one
category at once by holding  down the Command key (Mac) or the Ctrl key
(Windows) as you click on each line. To select a whole list of Categories, click on
the first item, hold down the Shift key, and then click on the last item. All lines in
between the two clicks will be selected.

Text Formats
Since CatBase is a database and not a word processor or page layout pro-

gram, the text that you type into the various fields is unformatted – it all appears
in the same font, size and style. The desired styles are applied when the data is
transferred to the publishing destination. So what happens if you want one or two
words or phrases within some text formatted in a special way? For example, you
may want publication references to be set in italics. CatBase provides a way to
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do this.
There is a button labelled Text Formats above the Notes and Description

fields on the Companies and Products screens. Click on this button to make the
Text Formats floating palette appear:

To select a text format, you simply select the text to which you want to apply
the format and then click on the appropriate button. The following table
describes the effect of each button, and its keyboard shortcut:

Button Effect Keyboard (Mac) Keyboard (Windows)
Plain Cmd-Shift-P Ctrl-Shift-P

Bold Cmd-Shift-B Ctrl-Shift-B

Italics Cmd-Shift-I Ctrl-Shift-I

Outline Cmd-Shift-O Ctrl-Shift-O

Shadow Cmd-Shift-S Ctrl-Shift-S

Strike through Cmd-Shift-/ Ctrl-Shift-/

Underline Cmd-Shift-U Ctrl-Shift-U

Word Underline Cmd-Shift-W Ctrl-Shift-W

Small caps Cmd-Shift-H Ctrl-Shift-H

All Caps Cmd-Shift-K Ctrl-Shift-K

Superscript Cmd-Shift-+ Ctrl-Shift-+

Subscript Cmd-Shift-- Ctrl-Shift--

Superior Cmd-Shift-V Ctrl-Shift-V

To apply a format to some text, select the text and then click on the appropri-
ate button in the Text Formats palette (or use the keyboard shortcut). CatBase
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will then insert the appropriate formatting codes into your text.
In the following example, three words will be formatted in bold, italics, and

underline:

Notice that special tags have been inserted around the text to be formatted.
When the data is exported for publication, these tags will be converted to the
tags that the publishing destination will understand. Not all text formats are sup-
ported by all publishing destinations;  the following chart describes who supports
what.

If a selected tag is not supported by the publishing destination, it will simply be
ignored. For example, if you have tagged some text to appear in outline, and you
export the data to HTML documents, the outline tag will be ignored.

Pictures
Each Company, Product and Category record can have a picture associated

with it. To set the pictures up for Company and Product records, click on the
Picture tab. The following example is from a Company record:
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For Categories, the Picture information is set up on the main category screen
(please refer to Chapter Two for more information about setting up Categories).

If you plan to use the pictures in your publications, they will have to be avail-
able as files; the format can be any format supported by the intended publication
destination.

Picture
You can paste a low-resolution picture into the Picture field. This is used for

reference only; it is not used in your publications. It is not essential to have the
picture in this field, and in fact since graphics take up a lot of storage space, it
isn’t really recommended if you have a large number of records with pictures. 

Picture Location
This is the important field as far as pictures are concerned: it contains the

exact location of the picture that you want to use in your publications. 
The placement of pictures in a publication is supported by some of the publi-

cation destinations supported by CatBase, and each has its own rules regarding
how it can locate the appropriate pictures when the data is imported. Picture
placement is supported by QuarkXPress, PageMaker Version 6.5 or later, and
HTML. You may have noticed that there is an additional field for Web Picture
Location; this is so that you can have a different version of the picture for publi-
cation on the Web than the one that is used in print. For example, you might use
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an EPS image for your printed catalogue but a JPEG image for the Web. 
The Picture Location actually consists of a pathname to the picture plus the

picture’s actual name. The pathname is the exact location of the picture, either
on your hard disk or any other volume that is accessible to the publication. You
can use either a full pathname or a pathname relative to the location of the docu-
ment into which the picture will be imported. A full pathname looks like this:

Drivename:Foldername:documentname

Of course there can be more than one level of nested folder (directory) names.
Some programs support both full and relative pathnames, and some have more
specific requirements; please refer to the chart below for details.

NOTE!
If you want to use the same picture both for print and for the Web, you must

put the same picture location into both the Picture Location and the Web Picture
Location fields, because when you export to HTML, CatBase will look in the Web
Picture Location field for the picture name.

The following table describes the rules for specifying the picture location for
various publishing destinations.
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Rules
1. You need to have a copy of the Xtags Xtension

installed.
2. The picture location can be either a relative

pathname or a full pathname. If it is a relative path-
name, the pictures must be within a folder that is,
itself, within the same folder as the Quark document
into which the data is being imported, and the path-
name must begin with a colon. Here’s an example of a
relative pathname:

:Pictures:catbase.jpeg

This means that there is a folder called Pictures in
the same folder as the Quark document, and within
that folder is the picture to use for this record.

Whether you choose to use relative or full path-
names depends upon your particular setup. The
advantage of using relative pathnames is that it
doesn’t matter if the main folder gets moved around
or if hard disks are re-named; as long as the picture
folder (or folders) and the Quark document stay
together in the same folder, it will work. This is useful
if you are going to send the job out to a bureau for
final output. On the other hand, if you are doing all the
production work in-house, the pictures could be locat-
ed on a file server somewhere on your network, in
which case you would use full pathnames.

3. The Quark document must be saved before you
import the file.

1. You specify the location of the folder containing
the pictures on the Preferences 1 page in your Export
Style Sheet. 

2. The Picture Location field should contain just
the actual picture name – the location of the folder
containing the pictures is specified in the Export Style
Sheet. 

1. The pictures must be in a folder which is in the
same folder as your HTML documents. 

2. The picture pathname goes into the HTML
Picture Name field.

3. The pathname is specified in this way:
Pictures:catbase.jpeg

where Pictures is the name of the folder.

Destination
QuarkXPress

PageMaker

HTML

DATA ENTRY

V. 4.17 3.15



Field Types
Each field is designed to hold a specific type of data, and you can easily tell,

by looking at an empty field, what type of data it will hold. 

Short Text Fields
Short text fields simply look empty when they contain no data:

Each field can hold a certain number of characters. You can see exactly what
the length of each short text field is on the Table and FIeld Setup screen.

Long Text Fields
Long text fields can hold large quantities of information (up to 32000 charac-

ters), and they are used for descriptions, notes, and that sort of thing. They look
like this:

A long text field can contain Return characters, whereas a Short text field
cannot.

Searching on a short text field  will always be faster than searching on a long
text field.

Integer and Long Integer fields
An Integer or Long Integer field contains a 0 until you enter something differ-

ent:

An integer is any whole number up to plus or minus 32,000, whereas a long inte-
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ger is a whole number of any size. You can tell whether a  field is an Integer or
Long Integer field by looking at its description in the Table and FIeld Setup
screen.

Real Number Fields
A real number field can hold any real number (i.e., a number that has decimal
places). The field looks like this:

The decimal point followed by two zeros illustrate that the field will hold decimal
numbers.

Date Fields
Date fields contain a date template:

You can type either 2- or 4-digit year dates. If you type in a 2-digit year, which
century it defaults to is determined by the Pivot Year that has been specified in
the Setup screen. This is described in detail in Chapter Two. 

Boolean Fields
Boolean fields hold “Yes/No” or “True/False” data, and they can appear either as
two radio buttons or as a check box:

In the check box version, if the box is checked then the field is “True” (or “Yes”).

Time fields
Time fields look like this:

It is very important that the correct type of field is used for holding various types
of data. For example, you can type numbers into a text field but you won’t be
able to perform calculations or  use them to sort the data numerically. Similarly,
you can enter dates into a text field, but you would not be able to search or sort
by date.

In the following sections you will find detailed descriptions of each data entry
screen.
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Companies

You can maintain information on other companies, such as your product sup-
pliers or any other address-based information such as personnel or association
members, in the Companies file. You don’t have to have any entries in this table;
if your CatBase database is to be used just for maintaining information on your
own company’s products, you might not need to use the Companies table at all. 

You can change the name oft he Companies table if you wish; this is
explained in Chapter Two.

To access the Companies table, choose Companies ... from the Data menu at
the main CatBase screen (or use the keyboard shortcut, Command-1 on Mac or
Ctrl-1 on Windows). The Search Dialogue will appear:

This dialogue box is described in detail in Chapter 4, Searching and Sorting. 
The pop-up list of “Search on:” fields contains the following options:

The choice you make here determines which field CatBase will search to find
the record or records you want. A brief explanation of each option follows.

Company Name: This is the default choice. Use this option when you want
to search for a particular company by name.

Contacts last name: You may have a number of contacts belonging to a
company, and this option lets you search for the company to whom a particular
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contact belongs. Suppose, for example, that you received a message that Bob
Johnson called and would like you to call him back. Unfortunately he didn’t leave
his company name or his phone number, and you cannot remember which com-
pany he works for. You could search for him by entering “johnson” into the Find
Companies area and choosing Contact last name from the pop-up menu. When
you click on the OK button, CatBase will search the database and find all compa-
nies having a contact with the last name of Johnson. They will be listed for you,
and you’ll then be able to locate the appropriate company.

Contacts Title: Like the Contacts Last Name search, this option enables you
to find companies having a contact with a particular title. For example, you might
want to find all companies that have a Marketing Director.

Category Name: This option searches for companies that have been assigned
to a particular category. (Note that you can also do this search from the
Categories list window).

Category Number: This option searches for companies that have been
assigned to a particular category number. 

No Categories: This option will find all Companies that have not been assigned
to any Categories.

Memo Key: When you create a Memo, you can enter a brief summary of what
the Memo is about into the Key field. This option enables you to search on those
comments. Memos are explained in detail later in this chapter.

Creating a new Company Record
To create a new Companies record, click on the New Record button (or use the

keyboard shortcut, Command-N on Mac or Ctrl-N on Windows). A blank
Companies record opens up:

Data Entry
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Of course, your fields may have different names to those shown here.
Companies Data Entry Screen: Address page
The Companies table data entry screen has six pages; this is the first.
CatBase creates a record ID number (Company Number) and enters it into the

ID field. You cannot change this number. 
You can use the Companies table for maintaining information either on com-

panies or on individuals (useful if you are creating something like a membership
directory). You can enter the company name or the individual’s last name into the
Company Name field, and the individual’s first name into the First Name field. You
can change the name of the Company Name field to something more appropri-
ate, such as Surname, if you wish; please refer to Chapter Two for instructions on
changing field names. A company name can be up to 70 characters in length.
When a company name is entered into the Company Name or Last Name field,
the window title bar changes to display the company’s name. 

✏ Enter “Robinson’s” into the Company Name field, and press the Tab key on
your keyboard. 

Address
The cursor is placed in the Address 1 field, and the window title bar has

changed:
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CatBase provides places for both a mailing and street address. You can enter
data into either or both areas. When creating an Export Style Sheet, you can use
a Formula to determine which address to use in your publication. Suppose, for
example, that some companies in your database have both a mailing and a street
address, while some have only a street address. You want to create a directory in
which each company’s mailing address is listed, if it has one; otherwise, you want
to use the street address. In the Export Style Sheet you create, you can use a
Formula to tell CatBase to use the mailing address if there is such an entry, but if
there is not, use the street address. Export Style Sheets and Formulas are
explained in detail in Chapter 7.

If you know that you are not going to use one of the blocks of Address fields,
you can hide them to make sure that data is not accidentally entered into the
wrong fields. This is done on the Table and FIeld Setup screen, which is
described in Chapter Two. 

✏ Enter Robinsons’ mailing address, moving from field to field by pressing
the Tab or Return key.

Internet and Email Addresses
There are four fields provided for Internet and electronic mail addresses:

Of course, you can use these fields for some other purpose if you want to,
and you can change their field names appropriately; you might want to have one
field for their web site address.

Phone Numbers
There are four fields for various phone numbers:

Companies Data Entry Screen: Categories page
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Click on the Categories tab or use the keyboard shortcut, Command-right
arrow (Mac) or Ctrl-right arrow (Windows), to move to the next page of the
record, which looks like this:

Categories
This included list shows the categories that have been selected for this

record. Selecting Categories is described in detail at the beginning of this chap-
ter.

Notes
You can enter any free-form notes, up to about 32,0000 characters, into the

Notes and Notes 2 fields. These notes could be information such as a description
of the company’s activities, which you may want to include in your publication.

You can apply special formatting to individual words or phrases within the
Notes fields by using the Text Formats palette (click on the Text Formats button
above the Notes field if the Text Formats palette is not visible). This is described
in detail at the beginning of this chapter.

No Products Listed
Notice the No Products Listed check box:
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When you create a new Company record, this box is automatically checked.
When a new Product record belonging to this company is saved, CatBase un-
checks this box for you. If you subsequently delete all related Product records,
the No Products Listed check box will be checked again by CatBase. (Note:
This sequence occurs when the Product records are actually deleted by the
System Administrator, and not when they are marked for deletion by any other
user).

The No Products Listed check box can be useful. For example, if you are
designing an Export Style Sheet for a catalogue that will include each company’s
name and address followed by a listing of its products, you could include a
Formula to export a special message if there were no products listed for a com-
pany. The Formula might look like this:

For a detailed explanation of Export Style Sheets and the Formula editor, see
Chapter 9, Exporting Data.

Word Count
If you want to know how many words you have entered into the Notes or

Notes 2 field, you can click on the Word Count button and CatBase will quickly
tell you:
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Companies Data Entry Screen, Contacts/Memos Tab
Click on the Contacts/Memos tab to go to the third page, which looks like

this:

There are two included lists on this page: Contacts and Memos. The Contacts
included list is explained next; Memos are explained later in this chapter.

Company Contacts
Each company can have any number of contacts. To create a new Company

Contact: 
➢ Click on the Add button below the Contacts included list area.
A new Contact record opens up:
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CatBase enters the Company Number, Name and Order  for you; you cannot
change these in this screen. 

You can designate a contact as the primary contact by clicking in the Primary
Contact check box. This feature is not used anywhere in CatBase; it is provided
for your information only.

The Title, Salutation and Job Function fields are choice list fields.
The Notes field is a free-form text field for keeping personal notes about this

contact. The field will hold about 32,000 characters of text.

Order
The Order field is provided for those situations when you want to specify a

particular order for the contacts to be sorted, and that order is not necessarily
dependent upon an entry in another field. For example, you might want to list the
Managing Director first, followed by the Treasurer, followed by the VP of
Marketing, etc. When you add a new Contact, the Order field is completed for
you. You can change their order by moving them up and down in the Contacts
included list.

The only mandatory field on this layout is Last Name. You don’t have to enter
anything into the other fields if you don’t want to.

Job Function
This field can be used to select a generic job function for each Contact. For

example, various contacts at different companies may have different marketing-
related titles such as Marketing Director, Director of Marketing, and so on, but
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you want to be able to easily identify all people responsible for marketing so that
you can send them a mailing. You could create an item in the Job Function list
called “Marketing Manager” and select this Job Function for the appropriate con-
tacts. You will then be able to find all the MArketing Contacts by the following
method:

➢ Choose Contacts from the Data menu.
➢ Select Job Function from the pop-up Search on: menu.
✏ Type “marketing manager” into the Find Contacts field. The Search

Dialogue should look like this:

➢ Click on OK to do the search.

When you have created a few Contact records for a Company, the Contacts
included list will look something like this:

Re-Ordering Contacts
To change the order of the Contacts, click on a line and drag it up or down in

the list, then let go of the mouse button when it is in the desired position.

The Pri? tick indicates whether this contact has been designated as the
Primary contact. You will be able to use the company contacts in mailings, Export
Style Sheets, and in Memos (explained later in this chapter).
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You can also create Contacts by choosing Contacts … from the Data menu at
the main CatBase menu. This is useful when you have a number of Contacts you
want to enter for different companies.

Entry Information
The Entry Information area displays some details regarding the creation and

modification of the record:

Enter Date
When a new record is created, CatBase sets the Enter Date as the current

date. This cannot be modified. In a multi-user setup, the date is taken from the
date on the server, not the workstation.

Enter By
This is the user name of the person who created this record. It cannot be

modified.

Modify Date
The date on which the record was last modified. This cannot be changed.

Modify By
The user name of the person who last modified the record.

Any time this record is modified, the date of the modification will be entered
into the Modify Date field, and the user name of the person who made the
modification will be entered into the Modify By field. These fields can be useful
for searching for modified records. For example, you might want to print out all
records that were created or modified today so that they can be proofed, or you
may want to search for all records that haven’t been updated since the beginning
of the year. To do a search like this, choose Companies from the Data menu and
when the Search dialogue appears, click on the Search Editor button. Set up
your search like this:
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This will find all records that have not been modified since the end of 1998.

The Search Editor is described in detail in Chapter Four.

Inactive
The Inactive area allows you to flag records that you don’t want to use in your

publications, but that you do not want to delete.

Inactive
Click in the check box to make the record Inactive. When you create Export

Style Sheets to transfer your data from the database to your publication, you can
tell CatBase whether or not you want to include Inactive records:
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If the Include inactive records checkbox is not checked, then Inactive
records will not be included in the export.

You might want to make a company Inactive in order to exclude it from certain
activities without actually deleting the record from the database. For example,
you have decided not to carry a company’s product line for a while because there
have been too many quality control problems with their products. But the compa-
ny has assured you they are handling those problems, and you will probably want
to carry the products again next season. For your next catalogue, however, you
don’t want the company included. By checking the Inactive check box, you will
be able to ensure that  the company and its products won’t be included. 

To make a company Inactive, click in the Inactive check box. Several things
happen when you do this:

1. The Inactive check box is checked (there will be an X inside it).
2. If the company has products listed, an alert box appears to advise you

that CatBase is also marking all related Product records as Inactive.
3. The current date is entered into the Date Inactive field.
4. Your user name is entered into the Inactive By field.
5. The window title changes to read “Company name; Inactive”.
You must also enter a reason for making the company inactive into the Why

Made Inactive field. You will not be able to save the record until an entry is made
into this field. Your explanation can be up to 40 characters in length. If you don’t
want to put a reason in, just type a space.

If you are using CatBase Multi-User, there is always the chance that another
user has one of the company’s product records open for editing or viewing. If this
is the case, CatBase will not be able to make the necessary change to that
record to mark it Inactive. CatBase will inform you this has happened, and will
print out a list of the Product records not modified. It will be your responsibility to
mark the listed products Inactive. 

To restore a company to Active status, simply click on the Inactive check box
again. CatBase will restore all related Product records to Active status, and reset
the Date Inactive, Inactive By, and Why Inactive fields.

Picture
The fourth tab is Picture. This is described in detail at the beginning of this

chapter.

Info
The fifth tab on the Companies screen is the Info tab. The screen looks like

this:
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This screen contains a number of fields that you can use for storing any addi-
tional data that you need to maintain. You can change the name of each field,
and you can tell CatBase to hide fields that you do not want to use so that  data
is not inadvertently  entered into the wrong place. Changing field names and hid-
ing fields is described in Chapter Two, Setting Up your Database.

The various field types are described at the beginning of this chapter.

More Info
The sixth tab on the Companies screen contains some more fields:
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➢ Click on the Save button to save the record. If another new
Company record appears, you can either enter another new Company or
click on the Cancel button to return to the main screen.
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Products

This is where you maintain data on the products to be listed in your publica-
tion.

To create a new Product record:
➢ At the main CatBase screen, choose Products ... from the Data menu. The

Search Dialogue appears:

This dialogue is explained in detail in Chapter Four, Searching and Sorting.
The pop-up Search On: menu offers the following options:

These options work in the same way as they do for Companies, as explained
earlier in this chapter.

➢ Click on the New Record button.

Product Record, Page One
There are five pages to the Product record. The first page looks like this:
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CatBase assigns an ID number to the new record, and displays it in the
RecordNumber field. You cannot change this number.

Name
A product name can be up to 70 characters in length. This field is mandatory.

✏ Enter a product name into the Name field, and press the Tab key on your
keyboard. 

CatBase copies the product name into the window’s title bar:

The cursor is now in the Company Name field. 

Company Name
If the appropriate option has been selected in the Setup screen, each product

must be related to a Company record. If you do not require this connection, you
can change the requirement in Setup; please see Chapter Two, Setting Up Your
Database, to find out how to change the setting. 

✏ Type an appropriate company name into the CompanyName field and
press the Tab key. Note that you do not need to enter the complete com-
pany name; CatBase will search to find a company with a name that starts
with the characters entered. 

CatBase searches for companies having names that start with the letters you

DATA ENTRY

V. 4.17 3.33



entered. If one match is found, CatBase will complete the Company Name and
Number fields for you. If no Company records beginning with the text you
entered are found, you will see the following alert box:

If you want to go ahead and enter a new Company record, click on Yes.
CatBase will create a new Company record for you to complete. When you save
that record, you’ll be returned to this Product record, and the new company
name and number will be entered into the appropriate fields in the Product
record.

If CatBase finds more than one record matching the text you entered into the
Company field, it will display a list from which you can select the appropriate
company name:

Double-click on a line item to select it. The company name and number
selected will be copied into the Product record for you. If you click on the Cancel
button, the list will go away and the text you typed into the Company Name field
will be cleared. Unless you have changed the default setting in the Setup screen,
you must enter a valid company name before the Product record can be complet-
ed.

You may also select a company for a Product record by typing the company’s
record number instead of its name. To do this: 

➢ Tab or click into the Company Number field next to the Company Name
field.

✏ Type the company’s record number.
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➢ Press the Tab key.
CatBase searches for the matching Company record number. If it finds one,

the company’s name is copied into the Company field; it no match is found, you
are alerted and the Number field is highlighted. You won’t be able to save the
record until a suitable company number or name is entered.

Categories

There is an included list on this screen for the Categories:

Categories are described in detail at the beginning of this chapter.

There are some additional fields on this screen for holding other product-relat-
ed data. We have given them names which describe the uses they might be put
to, but you can change the field names if you wish (this is done in the Table and
Field Setup screen, as described in Chapter Two).

Price Description

Price description is a text field that will hold up to 70 characters. This field is
designed for entering descriptive pricing information, such as “£35; with addition-
al gadget, £45” as opposed to the Price Numeric field, which is designed for
holding strictly numeric prices.

Price Numeric

The Price Numeric field is a real number field; you can enter only numeric values
into this field. You’ll want to use the Price Numeric field if you want to perform
any kind of calculation on the price (see the explanation of the Calculation ele-
ment type in Chapter 8, Export Style Sheets), or if you want to sort the records by
price. Which of these fields you use doesn’t matter as far as CatBase is con-
cerned; in fact you can use them both if you wish. However you’ll want to know
which field is being used when you create an Export Style Sheet so that you
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export data from the appropriate field. 

TIP: If you think that pricing information might be entered into either field for
any particular record, you can ensure that the correct field gets exported by the
use of a Formula element type in your Export Style Sheet. You would build a
Formula that selects the field which contains data. The Formula element is
explained in detail in Chapter 7, Creating Export Sheets.

Page Numbers
There are also two fields for entering page number data: Page Num Int and

Page Num Alpha. The Page Num Int field is an integer field; you can enter only a
whole number into this field. Page Num Alpha is a text field which will hold up to
20 characters. You might use this field for page numbering systems that involve
the use of alphabetic characters, or for entering more than one page number for
a product.

The page number fields can be very useful for creating indexes. While it might
seem like a lot of work to go through your publication and enter a page number
for every product, it could be quite a time-saver (and much more accurate) if you
intend to produce a number of different indexes for the publication. 

TIP: If you use the Page Num Int field, you will be able to sort the products by
page number. 

TIP: For QuarkXPress users, there is an easy way to have indexes built auto-
matically after you have transferred the data to your XPress layout. You can use a
Quark Xtension called Indextension, which builds an index based on index mark-
ers that have been placed around the text to be indexed in the Quark document.
All you need to do is install the Xtension, and then, in your Export Style Sheet,
check the Index check box on the Element for the item you want indexed (e.g.,
Product Name). Creating indexes using Indextension is described in Appendix F. 

Please see Chapter Seven for more information about Export Style Sheets.

TIP: If you have variations on a Product (for example, different colours or
sizes, or a list of parts that make up a product), you can use the Product Details
table to link the variations to the main Product record. This is described below.

Inactive
You might want to make a product Inactive for some reason, without actually

deleting the record from the database. That’s what the Inactive check box is for.

Suppose, for example, that you have just received information on a new prod-
uct. You want to make sure that it gets entered into the database, but you also
know that the product will not actually be available in time for inclusion in your
next catalogue. By marking the product Inactive, you can ensure that it gets left
out of the catalogue until you change its status back to Active. A check box on
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the Preferences 2 page of the Export Style Sheet screen lets you control this:

By default, the Include records marked for deletion and Include inactive
records check boxes are not checked in a new Export Style Sheet. If you do want
to include Inactive or Delete records, click in the appropriate check box to select
it.

To mark a Product as Inactive:
➢ Click in the Inactive check box. 
CatBase wants to know why the record should be deactivated:

You must enter something into the Why deactivated field.
Back at the Product screen, two things have changed: the Inactive check box

is checked, and the window title reflects the product’s status:

If you want to see the Inactive information without changing the status, click
on the Info button next to the Inactive check box. You will be able to view but
not change the screen shown above.

To change the status of a product back to Active: 
➢ Click on the Inactive check box again.
CatBase asks you to confirm that you want to change the status back to

Active. If you do, the Inactive check box is unchecked again, the Inactive infor-
mation is cleared, and the window title changes back to reflect the active status
of the product.

NOTE: When a Company record is made Inactive, all of that company’s relat-
ed product records are also marked Inactive. 
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Description/Details Page
The second tab on the Product record is the Description/Details page:

Description
This field is for the main description of the product.
You can format individual words or phrases within the text of the Description

by using the Text Formats palette (if it isn’t visible, click on the Text Formats
button above the Description field). For example, you may want certain words to
be printed in italics or bold. Text Formats are described in detail at the beginning
of this chapter.

Word Count
You can click on the Word Count button to find out how many words are in

the Description.

Product Details
You might want to have a number of Detail records for a Product. For exam-

ple, Spicey Cocoa might be available in five different flavours, or three different
sizes, or in several different kinds of package. You probably want to keep the
main product description and the detail data together, so that it can be published
in a format something like this:

Spicey Cocoa
Now available in Instant. By popular demand, we
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have added the milk and sugar to our flavoured
cocoa so you can enjoy them at work, at school and
at play as well as in your own home.

10320 Instant Spicey Cocoa £5.00
10335 Spicey Mint Cocoa £5.00
10345 Amaretto Cocoa £5.00
10410 Mixed flavours £5.00

This can be easily accomplished by creating four Product Detail records. To
create Detail records:

➢ Click on the Add button below the Product Details list.
A new Detail record opens up:

We have given these fields names that will serve most purposes, but of
course you can use them in any way you wish (changing field names is described
in Chapter Two, Setting Up Your Database, under the Table and Field Setup head-
ing).

If you are following along with us, enter the following data into this Detail
record:
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➢ Save the record.
When you have added a few Product Details, the Product Details list on the

Product screen will look something like this:

To view an existing Detail record, double-click on its line within the Details list. 

To delete a Detail record:
➢ Click ONCE anywhere in the line of the item you wish to delete.
➢ Click on the Remove button below the Product Details list.
The Detail record is deleted.

To change the order of the Details records, click and drag a line up or down
within the list.

Sort Order for Product Details
The order in which the Detail records are sorted is controlled by a field in the

Product Details table called SortOrder. You’ll need to know this when you create
your Export Style Sheet, unless you plan to sort the records on one of the other
fields (such as the item number).

Each Product Detail record is related to one Product record, and you can have
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any number of Detail records related to one Product record. It’s important to
understand the relationship between the Product and Product Detail records for
building Export Style Sheets. There is a Relation element type which makes it
possible for you to retrieve data from records in a table related to the table on
which the Export Style Sheet is based. For example, if you have created an
Export Style Sheet based on the Products table, you will be able to create a
Relation element that will draw data from related Product Detail records. The
Relation element might be set up something like this:

For every Product record exported, CatBase will search for related Product
Detail records and export them also, formatted as specified in the Export Style
Sheet.

Export Style Sheets and Relation elements are explained in detail in Chapter
7, Export Style Sheets.

Memos/Other Tab
The third page of the Product record is the Memos/Other page:
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On this screen are various fields which can be used in any way you please.
You can change the names of the fields and hide ones that you do not want to
use; please refer to the Table and Field Setup section in Chapter Two for informa-
tion about this.

Record Statistics
CatBase keeps track of when the record was created and by whom, and when

it was last modified, and by whom:
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Memos
You can create Memos for any Product record:

When you have a Product record open and you create a Memo, that Memo
will always belong to that particular Product record.

Memos are explained in detail later in this chapter.

Picture Tab
The fourth page of the Products record is the Picture page:

Pictures are described in detail at the beginning of this chapter.

Misc Tab
The fifth page in the Product record is the Misc page:

DATA ENTRY

V. 4.17 3.43



Here are a number of fields of different types which you can use to maintain
your data. You can change the field names and hide any fields that you don;t
want to use; this is explained in the Table and Field Setup section of Chapter
Two.

Saving a record
To save the record, click on the Save button .
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Scanning Text
If you have large quantities of text to type into the database, and
that text is available in typed or printed form, you can save your-
self some time by scanning it directly in. 

Currently, this feature is only available for Macintosh. If you are using CatBase
Multi-User, it doesn’t matter what platform the server is, as long as the worksta-
tion doing the scanning is a Macintosh.

To be able to use this feature, you need to have three additional things:

1. A suitable scanner
2. A copy of Textbridge Pro OCR software, version 8 or later.
3. Applescript must be installed on your Macintosh.

Scanners
You can use any scanner, as long as there is a TextBridge-compatible driver

for it. You will find a number of drivers on the TextBridge installation CD. You can
find information about TextBridge and which scanners it supports on the
TextBridge web site (www.textbridge.com).

If you are planning to buy a scanner specifically for this purpose, the feature
to be most concerned with it the scanner’s speed. Resolution is not very impor-
tant; you will get excellent scanning results at resolutions as low as 300 dpi, and
levels of colour are not important because the text will be scanned in black &
white. You may want to consider purchasing a document scanner if you need to
scan lots of text. A document scanner is designed specifically for scanning large
quantities of text; they usually work only in greyscale and are very fast. We have
found the Fujitsu models to be very good and reasonably priced; you can get
information from their web site (www.fujitsu.com). 

Please contact CatBase Software if you need any help or advice with this
(send an email to support@catbase.com).

TextBridge Pro
We have selected TextBridge Pro as the OCR software because it is scriptable

(meaning that it can be controlled from within the CatBase database), and it does
an excellent job of converting text. To set it up:

1. Install TextBridge as described in the installation manual, making sure that
you install the correct driver for your scanner.

2. It never hurts to assign it some extra memory.
3. Launch TextBridge and choose the appropriate settings: scanner options,

page size, and so on. Make sure that the scanner is set  up and working correctly
by scanning a few test pages.

4. Create a new Company or Product record in CatBase (or open up an exist-
ing one) and click in the field into which you want to import the text (most likely,
the Description or Notes field).
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5. Put the page to be scanned into the scanner.
6. Click on the Scanner button ( ).

If you do not already have Textbridge running, you’ll be prompted to locate it.
If you do not have AppleScript correctly installed, you will be informed of this

and the scanning process will be aborted.

Shortly the Scanning Progress window should appear:

The scanner will then scan the page, and before long the text will magically
appear in the field:

If it seems to take too long to scan the text, you probably need to think about
getting a faster scanner and/or running CatBase on a faster computer.
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Memos

Memos are a very useful tool for keeping track of things you need to do,
important events, and miscellaneous things to remember; they can also be used
to communicate with other people on your CatBase network.

➨ A Memo may be either Public (available to everybody using CatBase) or
Private (available only to the user who created the Memo).

➨ The person who creates a Memo is its Owner initially; however, the
Memo’s creator can change the Owner name so that another person
becomes its Owner.

➨ Each person can choose to have a list of his or her current Memos pre-
sented when he first logs on to CatBase.

How Memos work 
Memos can be attached to either Company or Product records, or they can be

free-floating.

Creating Memos
To create a memo for a Company or Product record:
1. Open up the appropriate record.
2. Go to the tab that has the Memos included list (Memos/Other in Products,

and Contacts/Memos in Companies).
3. Click on the Add button, below the Memos included list.

To create a free-floating Memo:
Choose Memos from the File menu and click on the New Memo button.

The Memo screen looks like this:
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Owner
When a new Memo is created, the user name of the person who created it is

entered into the Owner field:

You can change the Owner by typing another person’s user name into the
Owner field. The user name you enter must be a person who has been set up in
the CatBase database as a User. To change the Owner name:

➢ If the Owner field is not already highlighted, click or Tab into it
✏ Type the user name of the person to whom you want to give this Memo.

You don’t have to enter the complete name; just enter the first part.
CatBase will look up the complete name for you when you  press the Tab
key.

If CatBase finds more than one user name matching the text you entered,
you’ll be given a list from which to choose.

If no matching user names are found, CatBase tells you that and puts your
user name back into the Owner field.

You can use this as a method of transferring requests, comments, or other
information among CatBase users. Here’s an example:

You take a phone call from one of your suppliers regarding the placement of
his product in your last catalogue; he’s complaining that it was in the wrong cate-
gory. This is something for Kate to handle, but Kate is out of the office for a cou-
ple of days. You could:

➢ Open up the Product record for the product in question
➢ Go to Page Three of the Product record
➢ Create a new Memo
➢ Change the Memo’s Owner to Kate
✏ Type a message in the Comments area explaining the conversation you

had with the supplier
✏ Set a followup date two days from today
✏ Type a brief comment into the Key field
➢ Save the new Memo.
When Kate gets back into the office, the next time she logs on to CatBase

she’ll get the Memo that you sent to her: if she has opted to have her current
Memos shown to her when she logs onto the database it will appear as soon as
she starts up, otherwise, she will see the Memo when she opens up that record
or views her current Memos by choosing Memos … from the File menu.

Table and Record

When you create a new Memo for a Company or Product record, CatBase
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enters the names of the table and the record that were open at the time. If you
created a free-floating Memo, the Table will be Memos and the Record field will
be left blank.These fields cannot be changed by the user. A Memo that is created
when a Company or Product record is opened will be attached to that record.

Contact

You can either type a contact name into the Contact field, or have CatBase
look it up for you. To have it looked up:

➢ Click on the Lookup button.
CatBase searches for contacts belonging to the Company whose name is list-

ed in the Record field (if the Memo is being created for a Company record), or the
Company to which the Product is related (if the Memo is being created for a
Product record). 

If no contacts are found for that company, CatBase informs you and the
Contact field is left blank.

If one contact is found, his or her name is copied into the Contact field.
If more than one contact is found, CatBase will present you with a list of con-

tacts from which you may choose. You can enter a contact name that is not in the
database by simply typing it in.

Initiated via

Do you want to keep track of what prompted the creation of a Memo? That’s
what the Initiated via field is for. 

Entry Time

The time at which this Memo was created, using the 24-hour clock. You can-
not change this entry.

Comments

Type the details of the memo here. You can enter comments of any length into
this field.

Response

This field can be very useful if you are using CatBase for any marketing func-
tions. This is a choice list field; enter something into the field or make a selection
from the list by clicking on the arrow.

Entry Date

The date on which this Memo was created. It cannot be changed by the user.
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Key

Type a brief key phrase into this field. It will be displayed in the list of Memos
that appears on the Company or Product screen. You can search on this field for
Memos belonging to Company or Product records from the Search dialogue. 

Here is an example of how this might be used:
You have been contacting the Companies in your database to check that you

have their current product information. Some of them have asked you to send
them a copy of your last catalogue, and when they did, you created a Memo for
that company and entered a comment such as “Send catalogue” into the Key
field. Now you are ready to send out all the requested catalogues. At the main
CatBase screen:

1. Choose Companies … from the Data menu.
2. At the Search Dialogue, choose Memo Key from the pop-up menu and

enter “send last cat” (without the quotation marks) into the text area. The
Search Dialogue would look like this:

3. Click on OK.
CatBase searches and finds all the companies that have requested your cata-

logue. You will then be able to easily create mailing labels, or a personalised let-
ter (using the 4D Write word processing module).

Followup Date 

You enter the date on which you want this Memo to appear into the Followup
Date field. On the appointed date, the Memo will appear:

➢ When the Owner logs on to the database, if he has the automatic
notification option set (this is explained a little later in this chapter)

➢ When the Owner opens the Company or Product record to which the
Memo belongs

Of course, all Memos can be viewed at any time by choosing Memos ... from
the File menu (this is explained a little later in this section).
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Public or Private 

By default, a new Memo is always Private. This means that only its Owner can
view it. If the Memo is linked to a Company or Product record, it will be displayed
only for its Owner, on or after the Followup Date, on the screen for the appropri-
ate Company or Product.

You can make a Memo Public by clicking in the Public radio button. It will then
be available to all CatBase users. You can use this function as a general-purpose
reminder system. For example, you want to remind all users that the deadline for
updating the database for the next catalogue is March 15. You could create a
general Memo, put a suitable message into the Comments field, make the Memo
Public, and set a followup date of March 10. Everybody will see the Memo on or
after March 10.

Note: Only the Owner of a Public Memo can delete the Memo record.

When you save a Memo, it will appear in the Memos included area on the
Product or Company screen (unless it’s a free-floating Memo):

Summary information about the Memo will be displayed in the Memos area:

Viewing Memos

You can view Memos at any time by choosing Memos ... from the File menu.
The dialogue box shown below will appear; from here you can specify which
Memos you want to view:
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Mine Only/Public

The Mine Only radio button is selected by default. If you leave this option as it
is, CatBase will search only for Memos of which you are the Owner. If you select
the Public radio button, CatBase will search for your Memos plus any Public
Memos that meet your criteria (determined by which of the other options you
select).

Current

When you click on this button, CatBase will search for all your Memos having
a followup date of today or earlier.

Today’s Only
This button will cause CatBase to search for all of your Memos having a fol-

lowup date of today; this is not the same as Current, which finds followup dates
of today and earlier.

No Date
This will find your Memos with no entry in the Followup Date field. This is a

good way to clean up your files; you can delete old Memos and check to make
sure that none have been forgotten.

New Memo
Creates a new free-floating Memo. A Memo created this way is not attached

to a specific Company or Product record. 
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Search Editor
Presents the Search Editor, in which you may perform a search on any field in

the Memos table. This can be useful if, for example, you remember creating an
important Memo regarding a magazine article you want to look up. You remem-
ber making a note about it in the Comments field, and that it had something to do
with colour separations. By using the Search Editor you would be able to search
for any occurrence of “colour separations” in the Comment field. The Search
Editor is explained in detail in Chapter 4, Searching and Sorting.

All Memos
Searches for all of your Memos, regardless of their followup dates.

Once you have found the Memos you want, you can view, modify, or delete
them, or produce reports based on them. (The Quick Report editor is explained in
detail in Chapter 5, Reporting.)

Deleting Memos

To delete Memos:
➢ Find the Memos you want to delete by using the dialogue box described

above.
If you are not sure which ones need to be deleted, and want to “eyeball” all

your Memos, click on All Memos.
➢ Once you have a list of Memos displayed, select the ones you want to

delete. 
➢ To delete all the Memos in the list, type Command-A (Mac) or Ctrl-A

(Windows) to select them all.
➢ To select a group of Memos from the list, click on the first one to be delet-

ed, hold down the shift key, and click on the last one to be deleted. All the
Memos in between your two clicks will be selected.

➢ To select random Memos in the list, hold down the Command key (Mac) or
the Ctrl key (Windows)  as you click on each Memo you want to delete.

When you have selected the Memos for deletion, choose Delete Selection
from the Modify menu.

NOTE: A Public Memo can be deleted only by its Owner.
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Deleting Company and Product Records

Company and Product records cannot be deleted directly by the user; they
can only be marked for deletion. Only the Administrator can actually delete these
records. This provides some security for your database: the Administrator can
check to make suer that records should really be deleted before they are ban-
ished forever from the database.

To mark records for deletion:
1. Search for the record or records you want to delete.
2. When the list appears on your screen, select the records to delete.
3. Choose Delete Selection from the Modify menu.
You will be asked to confirm that you want to mark the selected records for

deletion. 
4. Click on Yes.
If Record Deletion Tracking is “On”, you will then see the following screen:

The purpose of this screen is to enable you to keep a detailed audit trail of
records that are deleted from the database. If you are not that fastidious about
keeping track, then turn Record Deletion Tracking off (this is done in the Setup
screen).

If you Cancel this screen, the associated record will NOT be marked for dele-
tion.

The records are then marked for deletion, and this is shown in the Delete col-
umn in the list:
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To delete records marked for deletion:
1. You must log on as the Administrator.
2. Choose Delete Records form Database … from the Admin menu. You’ll see

this dialogue box:

Purge Deletion Records
Select this option to delete the Deletion records. These are the comment

records that were created when the Company or Product records were marked
for deletion, if Record Deletion Tracking was on.

Print Deletion Log
Select this check box if you want CatBase to print a list of the records it

deletes.

3. Select either the Companies, Products, or Purge Deletion Records  radio
button and click on Accept.

If there are any records marked for deletion, they will be listed.
Browse through the records if you like, to make sure that they really should be

deleted.
4. Select the records you want to delete (Command-A to select all in the list).
5. Choose Delete Selection from the Modify menu. You’ll be asked to

confirm that you do want to delete them.
6. Click on OK to delete the records.

Un-deleting Records
To “un-delete” a record that has been marked for deletion:
1. Search for the record you want to restore.
2. When you have a list of records on the screen, select the record or records
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to restore. Only select ones that are marked for deletion!
3. Choose Un-Delete from the Modify menu.
The Delete check box will be un-checked for the selected records.
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Data Entry Tips

Tabs
You cannot enter a Tab character into a text field -- if you press the Tab key,

this will move the cursor on to the next field. However, there may be times when
you want to put a Tab character within text. We’ve provided a solution to this:

Type in the following text: \tab
Note the use of the backslash (\) character. This must be followed by the word

“tab” without any spaces in between.
When the data is exported via an Export Style Sheet, any occurrence of the

text “\tab” will be changed into a proper Tab character.
Note that it is not necessary to put any spaces around the \tab text if they do

not belong within the text.

Non-Breaking Space
For QuarkXPress users only!
Sometimes you may want to use a non-breaking space within your text. While

this is easy to enter in Quark, that program uses a special character which is not
part of the normal character set. Therefore, a non-breaking space cannot be
typed into the database. However, there is a Quark tag that can be used for this
purpose. It is: <!/P>. Just type this code into your text where a non-breaking
space is required, and when the text is imported into Quark, it will be correctly
interpreted. (Note, however, that non-breaking spaces are not always handled
consistently in Quark.)
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